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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may 
be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous 
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).
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What’s Inside

This publication provides a brief overview of how to install and operate the ClearMark™ Advanced Printer. For more 
detailed information, refer to publication 1492-UM011, ClearMark Advanced Printer User Manual.

Summary of Changes

This manual contains new and updated information as indicated in the following table.

Safety Information

Topic Page Topic Page

Printer Overview 4 ClearTools Software Installation 9

Rating Plate 4 USB Cable Connection 12

Setup 5 Operation 14

Unpacking 5 Starting ClearTools Software 14

Included Items 5 Mapping and Calibrating the Printer 14

Installation Considerations 5 Marker Cards 17

Remove the Transport Restraints 6 Touch Panel 18

Install the Output Rail 7 Cleaning and Maintenance 19

Position the Touch Panel 7 Printhead Cleaning 19

Connect the Power Cable 8 Printhead Flushing 20

Turn the Printer On/Off 8 Troubleshooting 22

Topic Page

Added battery directive disposal information Back Cover

WARNING: 
• Do not operate the printer without its cover and do not reach through its openings while it is running.
• Warning of hot surface: curing process makes marker cards very hot. Let marker cards cool off before removing them from the 

output rail.
• The openings in the enclosure of the printer must not be blocked or covered over.
• Do not insert any unintended objects through these openings.
• Make sure that no liquid gets into the printer.

IMPORTANT • Do not power off the printer. The printer automatically goes into standby mode. The operating parameters are only retained 
while the printer is turned on. These parameters ensure, for example, that the printhead is cleaned optimally.

• If the printer is turned off or is not used, this can lead to blockage of the ink nozzles after some time. 
• Printing marker cards every week is the only way to preserve print quality.
• Only remove ink cartridges when they are empty or have expired. 
• Removing an ink cartridge can cause leaks in the connection between the ink cartridge and the ink line. This can lead to a 

faulty ink feed system.
• Do not use ink that has expired.
• When the ink expiration date is approaching, a message is displayed on the touch panel. Replace the specified ink cartridge.

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um011_-en-p.pdf
https://www.rockwellautomation.com/global/literature-library/overview.page
http://literature.rockwellautomation.com/idc/groups/public/documents/webassets/browse_category.hcst
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Printer Overview
Figure 1 - Front view of the printer

Figure 2 - Rear view of the printer

Figure 3 - Open ink tank lid

Figure 4 - Connectors

Rating Plate
The rating plate contains information on the main 
voltage, article number, and serial number.

Item Description
A Touch panel
B Service cover
C Ink tank lid
D Output rail

Item Description
A Filter cover
B Connectors
C Marker Card input
D Stack input (loader)
E Cleaning fluid

Item Description
A Ink cartridges
B Ink Collector
C Ink tank lid (open)

Item Description
A Right-hand fuse (10 ampere)
B Main power supply connection
C Left-hand fuse (2.5 ampere)
D USB port for connecting Personal Computer

AB
C

D
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Setup
This section provides the information necessary to setup the ClearMark Advanced printer.

Unpacking

1. Open the packaging.

2. Take out all of the accessories.

3. Lift the printer with the polystyrene packaging material out of the box.

4. Remove the polystyrene packaging material.

Included Items
When you have taken the ClearMark Advanced and all accessories out of the packaging, make sure you have all the 
following items:

• Power cable
• USB cable
• 1 box of catalog number 1492-M5X5 Marker Cards
• Output rail
• DVD with the ClearTools™ software
• Quick Start guide
• Ruler for calibration

Installation Considerations
• Do not use the device near potential sources of electromagnetic interference, such as loudspeakers or the base 

stations of cordless telephones, because this can impair its function.
• Make sure you provide the necessary operating and maintenance spaces.
• The printer must be placed on a flat, stable surface. The printer will not operate properly if it is tilted or at an angle.
• Avoid locations that are subject to strong fluctuations in temperature and humidity.
• Do not expose the printer to direct sunlight, strong light, or excessive heat.
• Avoid locations that are subject to impact shocks or vibrations.
• In order to avoid the transmission of vibration, do not use a table joined to other tables.
• Avoid installation sites that are subject to a large amount of dust.
• Place the printer on a surface that extends beyond the base area of the printer on all sides.
• Leave enough space in front of the output rail to allow the printer to output Marker Cards without interference.
• Install the printer in such a way that it is sufficiently ventilated on all sides.
• Install the printer near a power socket so that the plug can be readily removed in the event of a fault.

IMPORTANT • Because of its weight, the printer must be carried by two people. Hold the printer at the front and rear when carrying it. 
• Transport the printer in a horizontal position. If it is transported improperly, ink may escape and soil or damage the device.

IMPORTANT Keep the original packaging for any future transport.
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Figure 5 - Operating and Maintenance Spaces

Remove the Transport Restraints

1. Remove the transport restraints from the touch panel.

2. Remove the transport restraint from the ink tank lid.

Item Clearance Distance mm (in.)

A 250 (9.84)

B 200 (7.87) output rail

C 100 (3.94)

D 250 (9.84)

E 100 (3.94)
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Install the Output Rail

1. Install the output rail by snapping into place as shown.

Position the Touch Panel
The touch panel can be raised up to three rest positions. A click sound indicates that the touch panel is engaged in one of 
the rest positions. After a fourth click sound, the touch panel is unlocked and can be gently lowered down.

1. Raise the touch panel to the desired position.

2. Rotate the touch panel by its handle (A) to the required position. The touch panel can be rotated 270°.

Figure 8 - Rotate the touch panel

Figure 6 - Touch panel lowered Figure 7 - Touch panel raised
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Connect the Power Cable

1. Connect the power cable to the printer (A) and 
verify that the plug is inserted firmly.

Turn the Printer On/Off

1. Turn on the printer by briefly holding down the 
on/off switch (A)

WARNING: 
• The supply voltage must match the voltage given on the printer rating nameplate.
• Only connect the device to a properly grounded and fused socket.
• Do not use a socket that is already being used by devices that are turned on and off at regular intervals, such as photocopiers or 

fans.
• Do not connect the printer to either a switch-operated or a timer-controlled power outlet.
• If you connect the ClearMark Advanced printer to the power supply via an extension cable, ensure that the total nominal current 

of all of the devices connected to the extension cable does not exceed the ampere rating for that extension cable. 
• Verify that the total nominal current of all devices connected to the wall socket does not exceed the ampere rating for that 

socket.
• When connecting the printer to the power supply, make sure that the building installation is protected by an appropriate 

backup fuse. 

SHOCK HAZARD: 
• Warning of electrical hazard if the power cable is damaged. 
• A damaged power cable can cause a fatal electric shock and lead to a fire.
• Do not place any objects on the power cable.
• Do not pull hard on the power cable and do not bend it any more than necessary.
• Failure to comply with these instructions can cause an electric shock or a fire.
• Insert the plug in a nearby socket and make sure that the socket is readily accessible.

A

IMPORTANT • Do not switch off the printer; the printer automatically goes into standby mode. 
• The operating parameters are only retained while the printer is turned on. These parameters ensure, for example, that the 

printhead is cleaned optimally.
• Turning off the printer or not using it can cause blockage of the ink nozzles after a while.
• Only turn the printer off to replace the service kit.
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ClearTools Software Installation
The marking system has been designed for the following operating systems: 

• Microsoft® Windows® 7 (32-bit/64-bit versions)
• Windows 8
• Windows 8.1
• Windows 10

You can find information about the application software in the ClearTools user manual, publication 1492-UM009.

1. Insert the supplied DVD in the personal computer DVD drive.

The DVD starts automatically.

2. Click Software.

3. Click ClearTools Software Installation.

IMPORTANT  Administrator rights are required for installation.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um009_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um009_-en-p.pdf
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The installation process starts automatically and the setup wizard appears.

4. Click Next.

5. Accept the terms in the license agreement and click Next.

6. Choose Typical setup type.
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7. Click Install.

The installation process starts and is shown by a progress bar.

8. When the installation is completed, click Finish.
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USB Cable Connection

1. To add the ClearMark Advanced printer, click Add.

2. Click USB.

The printer search starts.

The search result is displayed.

If no printer was found, you may start a new search process by clicking Search Again.

Item Description
A USB port
B USB cable

IMPORTANT When you have installed the ClearTools application software, connect the USB cable 
to the printer. The printer driver is installed automatically.

B A
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If a printer was found, click Add. The following dialog box appears:

3. If you want to change the printer name, click Properties. 

This changed printer name is then displayed in ClearTools.

4. Enter the printer name required for ClearTools, for example CMA Workplace 1 (USB1).

5. Confirm your inputs and click OK.

The changed name CMA Workplace 1 (USB1) is displayed in the Explorer.

You can remove the highlighted printer from the list by clicking Delete.

You can add this printer again at any time.

To exit the dialog box, click close.

To check whether the printer highlighted in the list is connected and accessible, click Test.

You see the following message if the printer cannot be found because, for example, it is turned off: Dialog box - 
printer not found.
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Operation

Starting ClearTools Software

1. Start ClearTools software via the program icon on the desktop or via Start menu.

Mapping and Calibrating the Printer
A printer must be assigned for each marker card catalog number, for example: 1492-M5X5.
Calibration must be carried out once for the printer, as this is a printer-specific zero point.

Assigning a Printer and Selecting a Marker Card

1. From the Catalog, choose for example, Marker Card>Terminal Markers.

2. Select the catalog number 1492-M5X5 Marker Card.

3. Click Select Product.

4. From the File menu, choose Print.

5. Select the ClearMark™ Advanced printer that has been added.
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6. Click Map.

7. In the dialog box that follows choose As Printer and click OK.

8. In this dialog box choose whether you want to assign all variants of the 1492-M5X5 Marker Card to this printer.

If you click Yes, all versions of the Marker Card type 1492-M5X5 are assigned to the ClearMark Advanced printer and 
are always output on this printer unless this setting is changed.

Printer Calibration

1. From the Start Menu, click ClearMark Advanced.

IMPORTANT Video instructions are included on the DVD. For more information on calibration, see ClearMark Advanced Printer User Manual, 
publication 1492-UM011.

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um011_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um011_-en-p.pdf
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2. Click How-to Videos.

3. Click Calibration.
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Marker Cards
Marker Cards can be inserted directly without any prior handling. The end with the solid margin must be fed into the 
printer.

Processing a Single Marker Card
Place marker card on the conveyor belt (A) in the direction of the arrow.

Processing a Stack of Marker Cards
Place the stack of marker cards (A) on the holder.

IMPORTANT • Only marker cards are allowed to be inserted in stacks.
• You can insert a stack of up to 30 marker cards in the loader.
• The stack must not contain a mix of full-size and half-size marker cards.
• Insert the stack of marker cards in the loader (A) in the direction of insertion shown previously. 

A

A
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Touch Panel
• View and delete print jobs
• Perform maintenance
• Provides ink level information and alerts when the cartridges should be changed
• Set the touch panel language
• Print out sample templates 
• Can be raised and rotated to the position you require

Main Menu

The printer status is shown in the bottom line. In the example above the printer is Ready. 
From the main menu, choose the appropriate sub menu: TEMPLATES, PRINT JOBS, TOOLS, or SYSTEM INFO.
The bottom part of the main menu shows the ink level of the individual cartridges. You can find exact details of the ink 
level under SYSTEM INFO in the second window. 

Submenus

Item Description

Displays the next page.

Displays the previous page.

Takes you back to the main menu

The currently selected menu, for example System Info, is shown at the top of the touch panel.
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Cleaning and Maintenance

Printhead Cleaning
Carry out printhead cleaning if the print quality deteriorates.

1. Press TOOLS in the main menu.

2. Press PRINTHEAD CLEANING in the Tools menu.

3. Press NO if printhead cleaning should not be executed.
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4. Press YES if printhead cleaning should be executed.

Printhead cleaning takes approximately 2 minutes. The following message is displayed on the touch panel during 
printhead cleaning:

5. Print out a marker card. 

If the printing result is still not satisfactory, execute printhead flushing.

Printhead Flushing
If you have carried out printhead cleaning and the printing result is still not satisfactory, execute printhead flushing. With 
printhead flushing, considerably more ink is used than with printhead cleaning.

1. Press TOOLS in the main menu.
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2. Press PRINTHEAD FLUSHING in the Tools menu.

3. Press NO if printhead flushing should not be executed.

4. Press YES if printhead flushing should be executed.

Printhead flushing takes approximately 5 minutes.
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Troubleshooting 
A message on the touch panel indicates a printer fault or when an ink cartridge needs to be replaced.
Touch [SYSTEMINFO] in the main menu of the touch panel for more detailed information about this message and to 
see which measures should be taken. Change to the second page of the System Info and touch [PROTOCOL]. The 
event is displayed. Touch [DETAILS] to display further information and an appropriate proposed solution. 

Additional Resources
These documents contain additional information concerning related products from Rockwell Automation.

View or download publications at http://www.rockwellautomation.com/global/literature-library/overview.page. 

EXAMPLE The printing results are unsatisfactory. The printed image is too weak or is spotted. Check the printer status.

Printer Status Possible Solution

Has the printer not been used 
for a long time?

The ink might have dried up or the printhead nozzles are blocked. If necessary, clean the printhead. 

Is the printed image unclear or 
doubled?

Contact Rockwell Automation Technical Support. 

Is there a problem with the 
printer's location?

Make sure that the printer is located on a flat even surface. Install the printer at a site that is free from vibration.

A marker card is stuck in the 
printer

Power off the printer and then power it back on again.The card stuck in the printer will be fed out.

The print is irregular, either too 
strong or too weak

Check the following if there is a problem with the print quality, such as irregular print or inappropriate ink quantity:
Are you using an out-of-date ink cartridge?
Using expired ink reduces the print quality and can cause damage to the printer.

The printouts are dirty or 
spotted
Check the following if the 
printed marker areas are dirty 
or spotted:

Have you touched the unprinted marker areas of the marker card? 
Do not touch the unprinted marker area

Are the marker cards aligned correctly? 
• Check the alignment of the inserted marker card.

Are you using an original Rockwell Automation ink cartridge?
• Only use original Rockwell Automation ink cartridges.
• The printer may be damaged if you are not using an original Rockwell Automation ink cartridge or if you are using a refilled cartridge. 

Opening the ink tank lid during 
the print process

Printing is canceled if the ink tank lid is opened during the printing process.
If you open the lid before the heating unit has switched on, the printing process will resume as soon as the lid is closed.
If you open the lid while the heating unit is already activated, the heating unit will be switched off. The current marker card will be printed and 
fed out of the printer without fixation. 
A message is displayed on the touch panel.
The filling level of the ink cartridges is set to 'empty'. The printer automatically starts re-initialization of the ink tank system (takes up to 2 
minutes).

Resource Description

ClearMark Advanced Printer User Manual, publication 1492-UM0011 Provides more detailed information on the setup and user of the ClearMark Advanced Printer

ClearTools Software User Manual, publication 1492-UM009 Provides information to install and use ClearTools Software.

Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1 Provides general guidelines for installing a Rockwell Automation industrial system.

Product Certifications website: rok.auto/certifications Provides declarations of conformity, certificates, and other certification details.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um009_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um009_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1770-in041_-en-p.pdf
https://rok.auto/certifications
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um011_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um011_-en-p.pdf
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Rockwell Automation Support
Use the following resources to access support information.

Documentation Feedback
Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this document, complete the 
How Are We Doing? form at http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf.

Technical Support Center Knowledgebase Articles, How-to Videos, FAQs, Chat, User 
Forums, and Product Notification Updates. https://rockwellautomation.custhelp.com/ 

Local Technical Support Phone Numbers Locate the phone number for your country. http://www.rockwellautomation.com/global/support/get-support-now.page 

Direct Dial Codes Find the Direct Dial Code for your product. Use the code to 
route your call directly to a technical support engineer. http://www.rockwellautomation.com/global/support/direct-dial.page 

Literature Library Installation Instructions, Manuals, Brochures, and 
Technical Data. http://www.rockwellautomation.com/global/literature-library/overview.page 

Product Compatibility and Download 
Center (PCDC)

Get help determining how products interact, check 
features and capabilities, and find associated firmware. http://www.rockwellautomation.com/global/support/pcdc.page 

EEE Yönetmeliðine Uygundur. (In Conformity with the EEE Regulation)

Battery Notice: This product contains Perchlorate material. Special handling may apply. For more information, go to http://www.dtsc.ca.gov/
hazardouswaste/perchlorate/.

• At the end of its life, this equipment should be collected separately from any unsorted municipal waste.
• This product contains a sealed lithium battery which is permanently connected and should only be removed or replaced by 

trained professionals. 
• At the end of its life, the battery contained in this product should be collected separately from any unsorted municipal waste. 

The collection and recycling of batteries helps protect the environment and contributes to the conservation of natural resources 
as valuable materials are recovered.

Rockwell Otomasyon Ticaret A.Ş., Kar Plaza İş Merkezi E Blok Kat:6 34752 İçerenköy, İstanbul, Tel: +90 (216) 5698400

Allen-Bradley, ClearMark, ClearTools, Rockwell Automation, and Rockwell Software are trademarks of Rockwell Automation, Inc.

Microsoft and Windows are trademarks of Microsoft Corporation.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

Rockwell Automation maintains current product environmental information on its website at http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page.

http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/
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